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Getting Started
Before attempting installation, you should be familiar with using

Microsoft Windows and Windows programs.  If this is your first time
using a Windows-based program, it is recommended that you

familiarize yourself with the Windows environment by reviewing the
Windows Basics topic in your Windows help system.

The Getting Started chapter will familiarize you with the most

common functions of MaxSea.

Congratulations on purchasing MaxSea

These “Getting Started” instructions are designed to help you

become familiar with MaxSea and answer frequently asked
questions.  Although this guide includes a sizable amount of

information, MaxSea is designed to have you up and running within a
short time.  

This user guide is here to get you started, and do not replace

the extensive product documentation found under the HELP

menu in MaxSea.

To Ensure Successful Software Installation

If you are installing Maxsea for the first time, you should

have the following items:

 - Installation CD
 - Hardware Dongle (Or serial number from order sheet)

 - If you purchased MapMedia data (charts, tidal currents
or 3D data) you need to obtain an additional code (file)

called .mxconfig. This can be provided by your MaxSea
dealer, or automatically downloaded if you have an

internet connection on the PC running Maxsea.
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DO NOT LOSE DONGLE NUMBER (OR SERIAL NUMBER) WHICH

HAS BEEN PROVIDED TO YOU WHEN PURCHASING MAXSEA.
MAKE A COPY OF THESE NUMBERS AS WELL AS ALL

CONFIGURATION NUMBERS, AND PUT THEM IN A SAFE
PLACE.

Technical Support

There are many technical assistance resources available:

1 - This Getting Started Guide
2 - The complete User Guide found under the HELP menu in

MaxSea
3 - Visit www.maxsea.com for more information on these

products and more. Our web site is a complete independent
source of information and companion products for MaxSea.

Subscribe to the MaxSea Services under the Register section
and you can directly access your own MaxSea Data (My

MaxSea), our Knowledge Base and the latest Training Quiz.
4 - Our technical support team is available if you require

additional help installing or using MaxSea.
For boaters inside North AMERICA:

You may visit the FURUNO USA website
(www.furuno.com) and click on "Support", then

"Ask Furuno a question."
For boaters outside North AMERICA:

You may visit the MaxSea International website
(www.maxsea.com)

Ask MaxSea Support (support@maxsea.fr) a

question.

Registration

In order to access free weather data, you need to register your

MaxSea software. Just visit www.maxsea.com and click on the
Register section. You will need your dongle number (or serial

number) and the code configuration 1 (Code 1). This information can
be found in the MaxSea info screen (go to Help menu and choose

“About”) or on the printed paper sheet that came with your original
MaxSea software package.
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Foreword
The software, or the Hardware Key or the Software Key (virtual
Dongle) and the following License Agreement are your proof of

license.

MaxSea is a powerful electronic chart display

software. Except for some countries (as it is the case
in FRANCE), an electronic chart is NOT intended to be

used as a substitute for paper navigational charts
issued by official authorities and required by

international maritime laws.
Only official government charts and Notices to

Mariners contain all information needed for the safe
navigation, and as always, the captain is responsible

for their prudent use.

MaxSea International does not guarantee the

availability and/or the accuracy of the updated daily

FORECAST files issued by MaxSea Chopper. Weather
forecast files are NOT intended to be used as a

substitute for weather information issued by official
weather offices.

In addition, Tides and Tidal current data come from a
variety of sources. MaxSea International does not

guarantee the accuracy of values. Tidal values derived
and displayed on the screen are predictions only and

are NOT intended to be used as a substitute for
observed data by International Oceanography Centers

and the mariner.

Usage of MaxSea implies knowledge and acceptance
of this warning by the user.

This is a legal agreement between you (either as individual or
entity), the end user, and MaxSea International.  If you do

not agree to the terms of this Agreement, promptly return the
CD ROM package and the accompanying items (including

written materials and binders or other containers) to the
place you obtained them for a full refund.
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What You Should Already Know

Before using MaxSea, you should be familiar with using Microsoft
Windows and Windows programs. These instructions will not explain

basic Windows operations such as the use of a mouse, the selection
of icons, or the use of pull-down menus.  If you do not feel

comfortable with these operations, please familiarize yourself with
these functions before installing MaxSea. We also recommend that

you review the Windows Basics section under your Windows Help
menu.

 

MaxSea® SOFTWARE LICENCE AGREEMENT

Upon opening the package or initially installing the MaxSea®

software disk, a legal agreement between you (either an individual
or entity, hereinafter, the End User), and MaxSea International

S.A.S. is in effect.  If you do not agree to the terms of this
Agreement, promptly return the disk package and the accompanying

items (including written materials and binders or other containers) to
the place of purchase for a full refund.

1. GRANT OF LICENSE.

(a) Dedicated Use.  MaxSea International grants to the End User the
nontransferable, nonexclusive, right to use one copy of the

purchased MaxSea® software (hereinafter the "Software") on a
single computer ("Dedicated Computer").  The End User may

transfer the Software to another Dedicated Computer owned by the
End User; PROVIDED that the End User does not do so more often

than once every (30) days and no copies of the Software purchased
herein are retained for use on the original Dedicated Computer or

any other computer.  However, if the End User has selected a
hardware dongle key, then that individual may also temporarily use

the Software on an additional portable or home computer owned by
the End User.

(b) Transitory Use.  Notwithstanding the above (a), End User may
transfer the right to use the Software to another End User, if the new

End User of the Software agrees to have physical possession and
abide by the terms of an original MaxSea® Software License

Agreement at all times during the use of the Software.
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For the purposes of this section, “use" means loading the Software

into RAM, as well as installation on a hard disk or other storage
device (other than a network server).

2. COPYRIGHT.
The entire right, title, and interest to the Software, disk, manual,

and all updates, enhancements and maintenance modifications are
owned by MaxSea International, shall remain with MaxSea

International, and are protected by United States copyright laws and
international treaty provisions.  Therefore, the End User must treat

the Software like any other copyright material (e.g., a book or
musical recording) except that you may either:

(a) make a single copy only of the Software solely for backup or
archival purposes; or

(b) transfer the Software to a single hard disk, provided you keep
the original solely for backup or archival purposes.

You may not copy the written materials accompanying the Software.
3. OTHER RESTRICTIONS.

This MaxSea® Software License Agreement is proof of license to
exercise the rights granted herein and must be retained by the End

User. You may not rent or lease the Software, but you may transfer
your rights under this License Agreement on a permanent basis,

provided you transfer this License Agreement, the Software, and all
accompanying written material; retain no copies; and the recipient

agrees to the terms of this License Agreement.  You may not reverse
engineer, decompile, or disassemble the Software.  If the Software

has been updated, any transfer must include the update and all prior
versions.

LIMITED WARRANTY
MaxSea International warrants that:

(a) upon opening the package or initially installing the disk with the
Software purchased, the Software will perform substantially in

accordance with the accompanying written documentation for a
period of ninety (90) days from the date of receipt; and

(b) Any MaxSea International hardware accompanying the Software
will be free from defects in materials and workmanship under normal

use and service for a period of one (1) year from the date of receipt.
Any implied warranties on the Software and MaxSea International

hardware are limited to ninety (90) days and one (1) year,

respectively, with time of the essence.  Some states do not allow
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limitations on duration of an implied warranty, so the above

limitation may not apply.
END USER REMEDIES.

MaxSea International’s entire liability and the End User's exclusive
remedy shall be, at MaxSea International’s option, either:

(a) return to the End User of the price paid; or
(b) repair or replacement of the Software or MaxSea International

hardware that does not meet MaxSea International’s Limited
Warranty and that is returned to MaxSea International with a copy of

the End User receipt.  This Limited Warranty is void if failure of the
Software or MaxSea International hardware has resulted from

accident, abuse, or misapplication.  Any replacement Software will
be warranted for the remainder of the original warranty period or

thirty (30) days, whichever is longer.  These remedies are not
available outside of the United States of America.

DISCLAIMER
Except as expressly set forth herein, MaxSea International makes no

warranties, express or implied, regarding or related to the licensed
Software or material furnished.

LIABILITIES
MaxSea International shall not be liable under any claim, demand, or

action under this Agreement for any special, indirect, incidental,
exemplary, punitive, or consequential damages.

RELIEF
End User acknowledges that any unauthorized use or disclosure of

the Licensed Software is in violation of this Agreement may cause
MaxSea International irreparable damage, and End User agrees not

to contest MaxSea International seeking of injunctive or equitable
relief.

TRADEMARK
MaxSea® is a registered trademark of MaxSea International.  No

license, right, or interest is granted to End User in such trademark.

LAW
The validity, construction, and performance of this Agreement shall

be governed exclusively under law of The State of Washington.
AGREEMENT
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This Agreement represents the entire Agreement between MaxSea

International and the End User and can not be changed except in
writing and signed by both parties.

The information in the Software documentation and the
specifications included therein are subject to change without notice.

Should you have any questions concerning this Agreement, or if you
desire to contact MaxSea International for any reason, please write:

MaxSea International, Technopole Izarbel, 64210 BIDART, FRANCE.

Copyright ©2005, MaxSea International.

MaxSea is a Registered Trademark of MaxSea International
S.A.S.

NavCenter and TrueView are Trademarks of MaxSea
International S.A.S.

MaxSea use NetCDF, copyright from UCAR/Unidata.
MaxSea use HDF, copyright from NCSA.

Windows is a Trademark of Microsoft Corporation.
NavNet is a Registered Trademark of Furuno Electric

Company.
MaxSea uses GDAL which is a translator library for raster

geospatial data formats that is released under an X/MIT
style Open Source license. (http://www.gdal.org/)

Other product names mentioned herein may be Trademarks and/or
Registered Trademarks of their respective companies.
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Installing MaxSea

Hardware and System Requirements

A PC must meet the following system requirements to work with
MaxSea. Please verify these requirements before installation.

Minimum Recommended MaxSea's Choice

Computer

Processor

Processor

800 Mhz

Intel® Pentium® M ,

Intel® Pentium® IV or
equivalent, greater

than 1GHz

Intel® Pentium® M

greater than 1.5GHz
Intel® Pentium® IV
or equivalent, greater

than 3GHz

Motherboards - Chipset 800MHz
Intel® 915 + chipset

800/533 MHz FSD

USB  
OR Parallel
Port(s)

Serial or USB port(s) - for connecting navigation
equipment (NMEA interfacing): an adapter must be used
for USB connections - see the section on connecting

equipment for more information.
If a DONGLE is being used to license MaxSea, a
dedicated parallel or USB port is necessary.

RAM Memory
256 MB
SDRAM

DDR 512 MB
2 X 512 MB DDR-
SDRAM PC3200

Video card

directX9

compatible
 video card

(64MB)

directX9 compatible

video card (128MB)

DirectX9 compatible

256 MB PCIExpress

Hard Disk 20 GB 40 GB 120 GB ATA133

Network
Ethernet

10 bits
Ethernet 100 Mbits Giga-bit LAN

Screen color Screen color, 32-bit color display

Optical drive
24X CD ROM for installing MaxSea, DVD for installing US

NOAA Raster charts



MaxSea Marine Software

9

Operating
System

Windows®
2000 with

SP4

Windows®  XP
HOME VERSION

Windows®  XP PRO

MaxSea Software Licensing

There are three different methods of licensing a copy of MaxSea: a
Software Key (no Dongle), a parallel Dongle, or a USB Dongle.

Using Software key (Virtual Dongle)

If you have decided to license MaxSea with a software-based key,

the software registration routine is started when MaxSea is first
installed.

There are a number of ways to register your software and get the
Site Key:

•  You can access the Internet; this is the fastest way to

activate your software.
•  You can use email activation first time by sending your

request, after receiving your Site Key, you will have to
enter it with using the Manual Activation system.

•  You can ask for a Site Key to your dealer or to our
services providing both your Serial Number and Site

Code (if you choose the Manual Activation, the Site Code
appears in the Manual Activation dialog and you can copy

it to clipboard).

IMPORTANT – The Site Key registration only has to be done one
time per installation. If you have to install your program again on

the same or another computer, MaxSea International allows you
to store your license on our servers to retrieve it later.

Please refer to Installation Help chapter to learn more on how to

obtain a Site Key to register your MaxSea software.

Using a Hardware key (Dongle)
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Advantages of Hardware Dongle - A Dongle allows MaxSea to be

installed on any number of computers for back-up and planning
purposes. MaxSea can be run on a home/office computer, then on

the boat’s computer, by simply plugging the dongle into the
computer being used.

- If You Have a Parallel Dongle (25-Pin printer Connector)  

With the computer turned off, plug the parallel dongle you
received with MaxSea into the parallel port on the computer. (This

is often where a printer cable is plugged in.)  The dongle is a
“pass-through” connector which allows simultaneous connection of

a printer. Simply plug the dongle in first, and then plug the printer
cable into the Dongle.

IMPORTANT - Make sure the computer is turned OFF when

plugging or unplugging a parallel Dongle.

- If You Have a USB Dongle (Blue or Purple),

Do not plug the USB dongle into the computer until after MaxSea
has been installed.  Once MaxSea is installed, the USB dongle may

be plugged and unplugged with the PC power on.

Tip – The USB dongle which is shipped out with MaxSea will work
with USB hubs (small boxes that add more USB ports to a

computer).  Note, however, that many USB-to-serial adapters will
not work properly when connected to a hub. Also, some USB to

serial connectors do not transmit NMEA data:  make sure your
connector is NMEA compliant. Test your hardware configuration

before you leave the dock. More information about serial adapters
can be found in the “Connecting a GPS” section p16.
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Upgrading Your Existing MaxSea

IMPORTANT - If it is the first time you are installing MaxSea,

please proceed to “Installing MaxSea" on the next page.

If you are already running a version of MaxSea, follow these

instructions to upgrade your software.

1. Backup MaxSea data stored in the computer’s MY
DOCUMENTS folder:

It is strongly recommended that you backup the MY DOCUMENTS
folder on a regular basis - and especially before upgrading.  PC's

often include a built-in CD-burner (CDR drive).  This is probably the
most convenient way to backup your data.  

Files which store any tracks and marks as well as logbook data are
found in the "MY DOCUMENTS" folder. You do not need to back up

your charts. Charts typically take up a lot of space, and can be
restored if necessary from their installation CD.

 2. Uninstall the previous MaxSea Version to free space on

your hard disk

- MaxSea version earlier than V.10

Select ADD/REMOVE programs from the Windows Control
Panel found under "START | SETTINGS" menu.  Select the

MaxSea entry and click on the CHANGE/REMOVE button.
Follow the instructions on the screen to remove the

software.

-Other MaxSea versions

IMPORTANT - If your previous version worked with a
software license (no dongle), you must install the new

version in the same folder. Never manually delete the
"MaxSea” folder.
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- Insert the MaxSea CD-ROM. If the installation screen

does not appear, open up “My Computer” double click
on your CD-ROM drive, then open (double-click) on

“Setup.exe”.
- Click on Installation, choose your language, and

follow the instructions on the screen.
- Three options are displayed: Modify, Repair, Remove.

Select Remove and click Next and follow the
instructions on screen.

3.  Restart your computer.

Installing MaxSea

IMPORTANT - If there are any devices connected to a serial port
(power management device, Palm Pilot synch, etc.), disconnect

them. (These can be reconnected after MaxSea is run for the first
time.) Ensure the computer’s CD ROM is clean - the main reason

that installations fail is that the CD ROM is dirty.

- Insert the MaxSea installation CD. If the installation screen

does not appear, open up “My Computer” double click on your
CD-ROM drive, then open (double-click) on “Setup.exe”.

- Choose your Language and click on Install.
- Keep clicking “Next” and answering questions when prompted

until the installation routine is complete. In most cases, all of
the defaults may be accepted.  The software, some basic charts,

and the User Guide will be installed.
- Restart your computer if prompted to do so.  

- If you have a USB dongle (hardware key), now is the time to
plug it into your computer.  Windows will find it, and ask for

drivers. Accept the prompts and the drivers will automatically be
loaded.

MaxSea is ready to run. There are several ways to start MaxSea:
You can run MaxSea by double clicking on the MaxSea icon on the

computer’s desktop, or click Start | All Programs | MaxSea menu.
When you start the program for the first time, the Software Key

Activation Manager main screen appears if you have forgotten to
plug the Dongle into your computer, or if you are using a Software

Key licensing.



MaxSea Marine Software

13

Updating Configuration Codes

If your Dealer has not preconfigured your dongle, or if you use a

software key (virtual dongle), the "ConfigurationCodes Internet”

tool will start automatically the first time your run MaxSea. A dialog
box will alert you that the Internet connection is beginning to search

for updating codes on our server. One of the following processes will
need to take place:

If your computer is connected to the internet, the

configuration codes will be automatically downloaded and
installed using the "ConfigurationCodes Internet”

process.
If your computer is not connected to the Internet, "Error

203" appears and warns you that Internet connection has
failed. Message asks for searching the (*.mxconfig) file that

was given by your dealer or sent by email.

Note: On rare occasions, MaxSea could detect that the Hardware key and
software do not match. In this case, you must launch the DongleUpdate
program via the following procedure:

• Make sure you don’t have any programs running.
• Go to the Windows “Start” menu.

• Click on “Programs”.
•  Click on “MaxSea Utilities” then "ConfigurationCodes

Internet"
• If your computer is connected to the Internet, codes will be

automatically installed.
• However if your computer is not connected to the Internet,

"Error 203" appears and warns you that Internet connection
has failed. Message asks for searching the (*.mxconfig) file

that was given by your dealer or sent by email.
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Software User Guide

OVERVIEW
The Help Viewer provides an integrated table of contents, an

index, and a full-text search feature so information can be found
easily. Book icons open to reveal topic entries and sub-books.

The Help Viewer has the added benefit of showing the Table of
Contents, Index, or search results at the same time a Help topic

is being viewed. This maintains focus on the Help system and
allows view of all other applicable Help topics at a glance.
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Two ways to open the Help software

With MaxSea open, select [User Guide] from the [Help] menu or just
press the F1 key.

From the [Start] windows menu, select [Programs] > [MaxSea Utilities]
> [User Guide].

To Find a Help topic
In the Help Viewer, click one of the following tabs:

Contents tab

To browse through the Table of Contents, click the Contents tab.
Double-click the book icons to reveal topic entries and sub-

books.
Click a table of contents entry to display the corresponding

topic.
Index tab

To see a list of index entries, click the Index tab, and then either
type a word or scroll through the list. Topics are often indexed

under more than one entry.
Double-click an index entry to display the corresponding topic.

Search tab
To locate every occurrence of a word or phrase, click the Search

tab, type a word or phrase that you want to search for, and then
click “List Topics.” See “Find it fast” for more information about

refining and narrowing the search.
Double-click the search results to display the corresponding

topic.
There are three options for searching: Search previous results,

Match similar words (checked by default) and Search titles only.
Favorites tab

To bookmark a topic, use the Contents, Index, or Search tabs to
locate and then display a topic. Click the Favorites tab, and then

click Add to save the topic title to the Topics list.
Double-click a bookmark in the Topics list to quickly display the

topic.
Glossary tab

To find a term in the glossary, click on the term. The definition
appears in the frame bellow.
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Print Help Software:

To print a help topic, on the Contents tab select it and click
Print on the Help toolbar.

To print all topics within a book, on the Contents tab,
select the book. On the Help toolbar, click Print, and

check Print the selected heading and all subtopics
and click OK.

To print all the Help manual references, Acrobat Reader is
required. You will find two manuals (OperatorManual.pdf

and InstallationManual.pdf) under [Windows],
[Programs], [Maxsea Utilities].

Connecting a GPS receiver

In most cases, connecting a GPS to a computer is very simple, and

is accomplished by connecting a serial cable (normally supplied by
the GPS manufacturer) to the serial port on the PC.

The serial port is usually a nine-pin male port on the back of the

computer, and is often identified by an “IO” or “COM” symbol.
If you want to connect MaxSea to NavNet, please refer to the

appendix at the end of this manual (p. 74)

Serial to USB Cables
Newer computers (purchased after 2005) – especially notebooks or

tablet PCs – may not include a serial port. One can be added by
using a serial-to-USB adapter, which can be obtained from most

MaxSea distributors, computer stores, or on-line computer stores.
Adapters manufactured by KeySpan or Fitstream are preferred.

Connection Details

The PC's serial port (RS 232 type input/output port on COM) is
used for serial data input. Connect the GPS to this port using the

appropriate cable.  This serial port must comply with RS 232 type
serial data protocol standards.

The connection of a GPS to the computer is usually a 2-wire
connection with NMEA 0183 output from the GPS connected to

the input (RxD, pin 2) and ground (Gnd pin 5) pins of the
computer’s serial port.
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IMPORTANT - If your GPS has a RS 422 type connection, this
process cannot be used (you will need a RS422 to RS232

converter). Please contact your MaxSea dealer to obtain one.

Connection diagram for computer serial port (9 Pin Type D
Connector)

Pin Signal Information

2 Data reception Rx Connection to GPS

NMEA output

3 Data transmission
Tx

Connection to
automatic pilot or

other listener

5 Ground GND
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Installing Charts

- When using Maptech, NDI, or Softchart brand charts, we

recommend that you create a folder called “CHARTS” under the My

Documents folder in your PC, and then copy the charts from the CD
into this new folder. Maptech BSB4 charts need to be activated using

the Setup program found on each chart CD. This is easiest to do with
an Internet connection.  If you do not have an Internet connection,

contact Maptech at the telephone number located on the chart
r eques t  code  f ound  i n  t he  Map tech  box .

- Mapmedia MM2 charts use an installer program that will
automatically create a folder called “Mapmedia .mm2” in your PC’s

“My Documents” folder.
- NOAA USA raster charts DVD uses an installer that automatically

creates a folder called “BSB_ROOT” in My Documents.
- ARCS charts are installed utilizing MaxSea Utilities.

- C-Map CM/93 charts are installed utilizing the Manage CM93ed3 &
S57 Charts… option under File on the MaxSea menu.

- C-Map NT charts are installed using the tools on the C-Map CD
“NTPC Selector” installation program. To install these charts, open

(at least one time) the C-Map planning charts in MaxSea. To do this,
choose “Open Charts” in the File menu and select CMAP NT. Quit

MaxSea, and then launch the NTPC selector software from the C-Map
CD.  Be sure to have the MaxSea dongle plugged in the computer.

Unlock the charts using the NTPC selector. When charts are
unlocked, they will be available in MaxSea. You may need to reopen

them.
To open any Charts in MaxSea, simply choose “Open Charts” in the

File menu and then select the charts you want to open.

IMPORTANT - If you install Mapmedia charts v1, Mapmedia MM2,

Mapmedia 3D bathy data or Mapmedia Tidal Currents data, you
have to license the corresponding data. To register data, close

MaxSea, go to the Windows “Start” menu. Click on “Programs”.
Click on “MaxSea Utilities” and choose "ConfigurationCodes

Internet". Codes are automatically installed if you computer is
connected to Internet. If no connection is available, "Error 203"

appears and warns you that Internet connection has failed.
Message asks for searching the (*.mxconfig) file that was given

by your dealer or sent by email.
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Running MaxSea for the First Time

IMPORTANT - MaxSea will not run if protection is not activated
(Hardware protection with the "Dongle" or software protection

with the "Software License").

There are two ways to launch Maxsea:

Double click MaxSea icon on the Windows desktop. Or, go to the
[Start] Windows menu, point to [Programs] and then click the

MaxSea entry.
Electronic Chart Notice

When starting MaxSea for the first time, a warning will be
displayed, showing a reminder that the electronic chart display

capabilities are not in most cases a substitute for paper charts. To
acknowledge this warning, click on the I AGREE button. The DON’T

SHOW AGAIN box may be checked to not show this warning upon
the start of MaxSea.

MaxSea Registration
If you are connected to the Internet, you register MaxSea at this

time. Free registration is necessary to access weather data. Click
on "REGISTER HERE AND GET ACCESS TO OUR VARIOUS

SERVICES.” You can also mail or fax your registration to MaxSea
International. Check the DON’T SHOW AGAIN checkbox to suppress

the Help screen at future startups. To activate this screen again,
select USER GUIDE from the HELP menu.  Or, select DISPLAY USER

GUIDE AT STARTUP.

Opening Charts
When Maxsea is started, a large scale low resolution planning chart

“Planisphere” is opened by default. Depending on your MaxSea
software, (C-Map or Mapmedia,) you can open either C-Map or

Mapmedia planning charts. Click on “Open Charts” located under
the “File” menu, then choose either “C-Map NT” or

“Chart:Mapmedia2”, which are 1:10 million scale World Charts.
Note - More detailed charts, like free USA NOAA charts, will be

necessary for actual details planning and navigation. To open USA
NOAA raster charts, first install them with the DVD installer, then

click FILE, then “Open Charts.” Then select “Maptech&NDI.”.
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In MaxSea, you will be able to switch between Raster or Vector

charts - press the Vector Charts  or Raster charts 
buttons to switch.

Looking at the Chart Desktop

MaxSea opens into a familiar charting environment (Figure below).
MaxSea will display many different types of charts simultaneously.

The charts are arranged according to their geographical location

and their scale of representation. Let's take a brief tour around the
MaxSea Chart Desktop:
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The Chart Desktop (1) is the open window and consists of six
parts:

The Chart Window is docked at the top of the opened window
by default. The datum, type of chart and scale are displayed

in the MaxSea/Chart title bar (ex: [WGS84],   [Raster 1:25
million]).  Several chart windows can be opened at the

same time. The GPS/vessel symbol (6) is shown in each
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opened chart window. It shows the boat position derived

from the GPS data connected to the PC.
The Menu bar (2) organizes a number of drop-down menus

which allow you to configure and manage MaxSea data,
setup and presentation.

The Chart Toolbar (3) contains a series of buttons which
toggle on/off different layers. If a button is surrounded with

red, it means that the button is active and the
corresponding layer will be shown on the chart.

When there are multiple chart windows in use, the Chart
Palette applies to the active window. If a button is not

present, the corresponding module has not been purchased.
The Toolbar (5) is the tools control center. Each tool does a

specific job and can be selected with a left click of the
mouse. When a Tool is selected, the cursor changes

accordingly and the active Tool icon is surrounded with red.
The Cursor Data Box (7) displays cursor position.  By default,

this data is displayed on the right, or it is docked to the
edge of the window. Available data includes latitude,

longitude, Depth (if 3D data is available), Distance and
Bearing between the cursor and the vessel and the Time to

Go (TTG) based on the current vessel speed.
The Nav Data Bo x (8) displays GPS data and any other

instrument(s) input you have chosen to show. This data box
is displayed on the right by default, or is docked to the edge

of the software window.

Tool tips are temporarily shown when the cursor is placed on a
Tool Palette item or button for a few seconds. Use these tool tips

when you want to see a brief description of Tools and Buttons.
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Notes:
(1) - All the palettes in the chart desktop window can be displayed in two

different modes; "Floating Palette" or "Docked". Refer to “Setting your work
area” paragraph.
(2) - If raster chart data is not available for a selected scale, MaxSea will

enlarge or "over-zoom" the available raster data of the larger scale chart. In
this case, the text [Over Zoom] appears in the Chart window title bar.

Chart Toolbar

The standard Chart Toolbar contains buttons which toggle display
data on/off, according to the installed modules. The presence of a

button indicates that the specific module is installed.
By default, the chart palette appears along the top of the MaxSea

screen.
To move it, click and drag the symbol (on the left) to

detach it from the menu bar.

There are two types of buttons in the Chart Palette:

• Simple Buttons which allow direct access to a

specific function.

• Pull-down Menu Buttons allow you to choose

between items according to the selected function.

If a button is shaded red, it means that the button is active and its
corresponding layer will be shown on the chart.

 The buttons shown on your Maxsea software depends on your software
configuration. The omission of a button means that the corresponding module

is not available in the software. To get more information, please contact your
Maxsea dealer.
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Use the corresponding button from the charts palette to turn on/off

different functions:

- Auto Center activation button toggles on/off chart
auto-centering, placing the vessel in the center of the chart
screen (related topic: center mode).

-  Chart orientation button chooses the display
orientation, of which three modes are available: "North Up,"
"Head Up," and "Course Up." (The North up mode is selected by

default).

- Grid information toggles the grid display over the

chart ON/OFF.

- Vector Charts Information opens vector charts and
displays a drop-down list of opened vector chart types (CMap NT

/CM93)

- Raster Charts Information displays a drop-down list
of active chart types (the Planisphere.wld is displayed by default).

- Layer Information, shows a drop-down list of available
user data layers (PTF File) and shows/hides user data on the
chart.

- 2D Activation Button activates the 2D control palette for
setting and displaying 2D data on the chart (shading)

- 3D Activation Button toggles the 3D window on/off.

- Target Information   shows a drop-down list of
available Target data layers and shows/hides targets on the

chart.
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- Radar Overlay Information toggles radar display
on/off. The down arrow to its right is a drop down list of available

Radar display control such as the Radar rings, etc...

- Waypoints and Routes Information is a drop-down
list of available Waypoint and Route Layers.

- The Tides and Tidal Currents Button toggles on/off
tides for main ports of the world and allows you to turn on/off
Tidal Currents vectors from available Tidal Current layers list.

- Weather Information, once a weather file is loaded,
click on this button to display it on the chart.  If you click on the

arrow to the right of the weather button, you will be able to
choose which weather types you want to display.

- Time Information - When displaying weather or
tides/currents information, this control allows you to view future

or historical data. The clock turns red when the selected
date/time is different from the current time.

-  Time Period Information allows viewing

Weather and Tides/Currents data for time periods earlier or later
than current time. Click on the down arrow (on the right) to

change time step interval.

Chart Toolbar Options, click on the small down arrow at the
end / right of the chart toolbar to access the toolbar's properties

menu. From the properties menu, you can add or remove tools,
display or hide labels on standard buttons or large buttons, and

change the transparency of the palette. Note that this option is
only available when the palette is shown in a floating palette

configuration layout (undocked.)
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Toolbar

MaxSea utilizes tools and buttons to make operation
simple and easy. The "Tools Bar” displayed on the left

side of the screen will be used frequently.
The toolbar is displayed vertically on the left-hand side

of the screen by default. It includes both tools and
buttons that allow you to work on an electronic chart

as you would on a paper chart.
Select any tool or activate any button on the palette

by clicking on it.

The Toolbar consists of six parts:
1. Title Bar (small arrow and “X”) with access to

the display configuration parameters.
2. Activation Buttons (More Activation buttons

might appear in the Toolbar according to the
software configuration),

3. Navigation Tools

4. Capture and Modification tools
5. Marks / objects styles setup

6. Additional Display options

TIPS – Understanding the difference between a tool and a button

will make using MaxSea much easier. When selecting a tool from
the tools palette, the mouse cursor will change accordingly and

its function. For example, when the chart panning tool is
selected, (hand) the cursor changes to an open hand. Left mouse

click (and hold) on the chart with the panning tool (hand) to drag
the chart around. To enter a waypoint on the chart, change to

the Waypoint tool by clicking on the Pencil. Then when the
mouse is left clicked on the chart, a waypoint will be recorded.

Some icons on the tools palette are buttons (Zoom+ and Zoom-,
for example.) When a button is clicked, MaxSea responds

immediately. For example, click on the Zoom In button, MaxSea
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will magnify the chart immediately.  Any tool that was previously

selected (such as the panning or waypoint tool) will stay enabled
and the function will not change when clicking on a button.

Accessing Display Configuration Parameters

The title bar allows you to access and edit toolbar properties:

1. Left-clicking on the arrow in the upper right-hand
corner of the tool palette will display a tool checklist.  Check

the tools that you want to appear in the tool palette.
2. To return to the default display, choose Reset Toolbar.

3. Left-clicking on the “X” in the upper right hand corner

will close the Toolbar. To re-open the Toolbar, go to
[Display] on the menu bar and choose [Toolbar].

4. Right-click on the title bar to call up the contextual menu,
which allows changing the appearance of the Toolbar

(buttons small/large, six levels of transparency).
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Activation Buttons

 Man Over Board function

Single click on MOB button to drop a waypoint at current vessel
position. Double click to activate the "Man Over Board" function.

(For more information, see related topic under the Help: Man over

board function.)

 Track On/Off function

Click on the Track button to activate or stop track recording.
(See p.66 for more information)

&  Zoom in or out functions
The zoom function magnifies or reduces the chart scale.

(See p.50 for other methods of chart scaling)

 PBG On/Off function

Click on the PBG button to activate or stop the Personal Bathymetry
Generator

(For more information, see related topic under the Help: Import &
PBG )

&  Range plus and Range minus functions

The [R-] button decreases the radar range; the [R+] increases it.
When the Range function is operated in MaxSea, note that the Range

will be simultaneously applied to the radar range on the NavNet
display.
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Note (*): the omission of a button means that the corresponding module is not
available in the software. Specific buttons will appear only if your software is
configured with corresponding modules such as PBG module or Radar Overlay

module.

Navigation Tools

 Magnifying tool

Click the Magnifying tool to change chart scale. Simply click/drag an
area on the chart with this tool to zoom into it. Make a simple click

on the chart to zoom out, see related topic under the Help: Scale
choice. (See p.50 for other methods of chart scaling)

 Hand tool
Click the Hand tool to pan charts and access chart data. Single click

and press the left mouse button to grab the chart and pull it to
expose a new area. Double click the left mouse button to access the

Chart Properties box. (See p.53 for other methods of chart scaling)

Divider tool

Draw bearings and ranges in two different modes:
If the “Line" option is selected, you can measure distances and true

headings to and from any point to another on the chart. Click once

on a point on the chart, then left click on another point, and MaxSea
will give you the distance between the two points. To measure
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distance between your vessel and any point on the chart, simply

double click on the chart.
If the "EBL/VRM" option is selected, you may measure distance and

bearing of up to two targets. Choose EBL / VRM 1 for the first target
and EBL / VRM 2 for a second target.

To erase the divider line, double-click on the Divider Tool
(For more information, see related topic under the Help: Using EBL

and VRM calculations.)

 Bearing tool
The Bearing tool is a powerful navigational tool, useful in confirming

position and checking a location on the chart. To erase the bearing
line, double-click on the Bearing Tool

(For more information see related topic under the Help: Bearings)

 GOTO  tool
This tool provides a simple method to place a QuickWaypoint at the

cursor position, then actively navigate to that point. Double-click on

this tool to Cancel any Active Route. (See p.59 for more information)

 Route tool
This tool provides a simple method of creating a series of connected

QuickWaypoints. When completed, this is a called a route. Make sure
to Double-click on this tool before creating a new route to ensure

that there are no routes that are currently "selected”.
(See p.55 for more information)



MaxSea Marine Software

31

Capture and modification tools

 Plotting tool

  Waypoints   

 Layer.ptf [WGS84]

This tool allows you to create Waypoints, marks, lines and areas.
These items are stored and displayed in "layers” on your Maxsea

display. When you click and hold your mouse down on this tool, you

will be able to choose an active layer, of which there are two
different types:

- Waypoints layer: Using the pencil tool while this layer is active
will allow you to record waypoints (points that will be

navigated to or used in a route) on the chart
- PTF layer file: Using the pencil tool while this layer is active will

allow you to draw marks, circles, lines or areas (according to
user preferences) to a file. Although these marks will appear

on Maxsea, they can not be set as destinations or used in a
route.

Waypoints and marks may be saved, named and categorized, which
will allow you to save and call up different display scenarios and

show only the marks you want to see. For example, you might want
to only show marks and lines related to fishing a particular area by

saving and creating marks and lines in a layer file named “fishing.”
To make a new layer, click on the “File” menu of MaxSea, select

“New” and choose the type of layer you want to create.
(See p.63 for more information)

 Insertion tool
Used to insert a waypoint or a point in a route leg or line.

(For more information, see related topics under the Help: Modifying
marks and Modifying a route)
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 Position Modification tool

Click the tool, then select and move any object, point, or waypoint.
(For more information, see related topics under the Help: Modifying

Marks & Modifying a Route & Dead Reckoning function)

 Delete tool

Used to remove unwanted objects. Select the tool, then click on the
object you want to delete.

(For more information, see related topics under the Help:  Modifying
Marks & Modifying a Route)

 Split tool

The split tool is used to cut a line, track or route into two parts.
(For more information, see related topics under the Help: Cutting a

line in two parts or Cutting a track in a half)

 Select tool (Finger symbol)

   Lasso   

Rectangle

The finger tool allows you to get detailed information on an object.
Double click on any object (Waypoint or Tide icon, for example.) You

may also select multiple objects by utilizing these two methods:  
1. Draw a "Rectangle" around objects

2. Using the "Lasso," you can draw freehand selection areas.
 (For more information, see related topics under the Help: How to

select Marks & How to get Information on a Mark)
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Marks / Objects Style Set Up

Object type

Click on this button to pull down the plotting object type menu,
which will determine the type of mark drawn by the Pencil tool. You

can then easily select a plotting object, which can be a point, line,
area, circle, text or drift buoy. Once selected, the object type you

selected will appear on the button. This menu is only available when
a PTF layer file (Mark Layer) is selected with the Pencil Tool.

(For more information, see related topic under the Help: Adding
personal marks)

Plotting Icons
Use this button to choose plotting Icons / symbols for Waypoints and

Marks. The active icon / symbol will appear on the button once it is
selected.
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(For more information, see related topic under the Help: Adding

personal marks)

Text Font Size

Use this menu to choose text font size when you are applying text
onto your user chart layer. This menu is only available when a PTF

layer file (Mark Layer) is selected with the Pencil Tool.
(For more information, see related topic under the Help: Adding

personal marks)

Plotting Color

Click this button to select the color for your Marks and Waypoints.
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(For more information, see related topics under the Help:  Modifying

Marks & Modifying a Route)

Plotting / Drawing Line Width

Click this button to choose a line width. Once selected, all lines

drawn onto your user chart layer will use this line thickness. This
menu is only available when a PTF layer file (Mark Layer) is selected

with the Pencil Tool. (For more information, see related topic under
the Help: Adding personal marks)
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Plotting / Drawing Fill Type
Use this button to select the type of drawing fill. Once selected, all

areas drawn onto your user chart layer will have this fill applied.
This menu is only available when a PTF layer file (Mark Layer) is

selected with the Pencil Tool. (For more information, see related

topic under the Help: Adding personal marks)
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Additional Display Options

 Lighting Level display options

Use this button to select a lighting mode. Day brightens, Dusk grays
and Night darkens the desktop for most effective illumination. (For

more information, see related topic under the Help: Customize the
display)

 Chart Desktop Mode

1 Chart

1 Chart, 1 Profile

1 Chart, 1 Profile

2 Charts

2 Charts, 1 Profile

3 Charts

3 Charts, 1 Profile

4 Charts
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Use this button to select a Chart window layout. Toggle between only

one window or several windows, either of which may be shown with
or without the Depth Profile window.

Chart and Profile Modes depend on your software configuration.
The omission of Profile Modes means that the software doesn’t have
the Profile module.

Cursor Data Box

The Cursor Data Box is displayed at the upper right-hand corner
of the Chart window. It contains data pertaining to cursor location

and shows real-time information as the cursor moves over the
screen.

• To move the Cursor Data palette, left-click on its title bar,

hold the mouse button down, drag to the new position and
release the mouse button.

• Left-clicking on the “X” in the upper right hand corner will
close the cursor data box.

• To reopen the closed Cursor Data box, go to [Display] on
the menu bar and choose [Cursor Data].

The default location of the Cursor Data window is in the right upper
corner of the screen. Cursor Data shows the Latitude and

Longitude, bearing/course and distance between the cursor and
the vessel, and the time to go (TTG) at the present boat speed.
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Configure the Cursor Data window box by right clicking in its title

bar:
1. Change its transparency,

2. Choose a specific font size
3. Choose between a full display mode (all data are shown)

or reduced display mode (only data position are shown)
For more information see related topic under the HELP: "Customizing

the Cursor Data display" to find out more about Cursor Data display.

Nav Data Box

The Instrument Data Display Box (Nav Data) lets you see the

information being received from electronic equipment (GPS, central
navigation equipment) connected to the computer.

• To move the Nav Data box, left-click on its title bar, hold

the mouse button down, drag it to the new position and
release the mouse button.
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• Left-clicking on the “X” in the upper right hand corner will

close the Nav Data palette.

• To reopen closed the Nav Data palette go to [Display]

on the menu bar and choose [Nav data].
For more information see related topic under the HELP:

"Equipment Connection" to obtain more information regarding
instrument displays.

Notes:

(1) - You can select the data that you want to display in the data box. Just
right-click on the panel and choose “Choose displayed data…”
(2) - You can also customize the title/name of the data shown in the data box.

For more information see related topic under the Help: Selecting data for the
display.

Chart Desktop Window Settings

There are many ways to customize your Maxsea window

environment. You can easily choose how many chart windows you
want by clicking the Chart Desktop button on the Toolbar. This menu

allows you to set up your windows to view the same chart in
different windows and at different scales, and also lets you utilize

different layers in any of these windows - For example, the left
window could be raster with your navigation route overlayed, and

the right window could be radar overlaying you vector chart.

MaxSea allows you to customize the display of data, Toolbars and
Palettes on screen.

1 – Setting and Docking Palette / Data Box Location
a) - "Docking" layout display mode:

This mode helps you organize your Maxsea environment
when multiple tools, data boxes and palettes are in use.

MaxSea allows docking different menus to any
edge of the chart window. Left-click on the  , then

drag and drop the group menu at t h e  d o c k e d
destination.

b) - "Floating Palette" layout display mode: This mode
allows you to position the data independently.
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To move any palette, data box or tool bar, left-click on its

title bar, hold the mouse button down, then drag it to the
new position and release.

To resize any palette or tool bar, click on its border, hold
down the left mouse button until a double-headed arrow

cursor appears, then move the mouse in the desired
direction.  When the desired shape is shown, release the

mouse button.

2 - Setting the Palette Display
a) - Left-clicking on the "X" in a palette’s upper right hand

corner will close it. To reopen a closed palette, go to
[Display] on the menu bar and choose the palette to

reactivate.
b) - To change the size or to display titles in each palette

which contains buttons, right-click on its title bar, hold the
mouse button down, choose either "Large Buttons"  or

"Show text labels" under the menu and release the
mouse button.

c) - To change the font size or the transparency of a data
box, right-click on its title bar, hold down the mouse button

and choose an option. (For more information see related
topic under the HELP: "Setting the Cursor data box display",

"Setting the Nav Data Box display" and ”Setting the
Steering Data Box display").

d) - To select tools shown in the tool bar, click the down
arrow in the title bar, then select "Add or remove

buttons" and then select the tools to be displayed.

3 - Setting Chart Orientation
MaxSea displays the chart in one of three orientations:

North Up, Course Up, or Head Up.
To choose your chart orientation click the "C h a r t

Orientation" button in the chart palette at the top of the
screen. Select your preference as desired.

Notes:

(1) - To return to the default palettes positions, go to the [Display] menu on the
menu bar and choose [Arrange Display].
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(2) - All setting configurations are saved when exiting the software.

Context Menus and Chart Control Short-cuts

You can access some commonly used commands and Context-

sensitive menus by right clicking on an object or item in the chart
area.

To display Mouse (Right-Click) short-cut and context menus:

1 - Position the pointer over an object or a group of objects.

2 - Right-Click anywhere on the chart or on objects to view
the menu.

The Right-Mouse Menu consists of the following:

 - Display commands (Scale choices, Zoom in, Zoom out)

 - Properties, information, commands related to the selected
object

 - Capture and modify commands related to the selected
object

 - List of tools choices

Quick Links menus (tooltips) are also available on waypoints, routes,
c-map objects and AIS targets. To use these tooltips, position the

pointer over an object for a moment until a Quick Object Links
(Tooltip) appears. This allows you to quickly open selected object's

properties dialog box.
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Keyboard shortcuts

 P ress  on
Keyboard

Action:

Ctrl + O Open File in MaxSea

Ctrl + N Create a New File

Ctrl + S Save the Current File

Ctrl + W Close a File active in MaxSea

Ctrl + P Print  

Ctrl + A Select all objects from the current file

Ctrl + X Delete a selected object from the current

file

Ctrl + C Copy a selected object from the current
file

Ctrl + V Paste a selected object from the current

file

Ctrl + F Activate On/Off  Full Screen mode

Ctrl + D Unselect all objects from the current file

MaxSea Keyboard Shortcuts

Press on Keyboard: Action:

Ctrl + M Activate AIS MKD

Ctrl + T Activate AIS TX message

F1 Access the User Guide
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F2 Zoom In

F3 Zoom Out

F4 Center On/Off

F5 Track On/Off

F6 Create a logbook entry

F7 Activate Next Leg

F8 Activate Previous Leg

F10
Tides and Currents display

On/Off

F11 Weather display On/Off

F12 Activate Man Overboard

function

Shift +F1 Select Tool (switch between
tools)

Shift +F2 S w i t c h  b e t w e e n

Day/Dusk/Night

Shift +F4 Switch
NorthUp/CourseUp/HeadUp

Shift +F5 Activate the PBG On/Off
function

Shift +F6 Save Event

Shift +F7 Show/Hide Vector Chart

Shift +F8 Show/Hide Raster Chart

Shift +F9 Show/Hide Depth Profile
Window (*)
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Shift +F10 Show/Hide 2D Display (*)

Shift +F11 Show/Hide 3D Display (*)

Shift +F12 Radar Overlay On/Off (*)

Ctrl + F2 Radar Range -.(*)

Ctrl + F3 Radar Range +.(*)

Ctrl + F4 Radar Gain + (increase the

Gain with jumps of 10% on
integer values).(*)

Ctrl + F5 Radar Gain - (decrease the

Gain with jumps of 10% on
integer values).(*)

Ctrl + F6 Radar Sea Clutter + (*)

Ctrl + F7 Radar Sea Clutter –(*)

Ctrl + F8 Radar Rain Clutter + (*)

Ctrl + F9 Radar Rain Clutter – (*)

ALT + F1 Switch between Sounder HF

and LF (*)

ALT + F2 Sounder Range – (*)

ALT + F3 Sounder Range + (*)

ALT + F4 Sounder Gain – (*)

ALT + F5 Sounder Gain + (*)

ALT + F6 Sounder Shift – (*)
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ALT + F7 Sounder Shift + (*)

Right/Left/Up/Down

Arrows

Scroll Chart function (only

available if the active window
is the Chart window)

The + and - Zoom in or zoom out  (only

available if the active window
is the Chart window)

  (*)The inactive shortcut means that the corresponding module is
not available in the software.

Accessibility Windows Options Keyboard Shortcuts

Press on Keyboard Action:

Alt Activate the MaxSea menu bar
without using the mouse (then

use keyboard Arrows)

RIGHT ARROW Open the next menu to the

right, or open a submenu * or

move to the next right cell.

LEFT ARROW Open the next menu to the

left, or close a submenu * or
move to the next left cell.

UP ARROW Move up in the menu * or

move to the next upper cell.

DOWN ARROW Move down in the menu * or
move to the next down cell.

(*) When Alt key is pressed

TIPS - Palettes are accessed with the right and the left buttons of

your mouse.
To select a tool, place the cursor over the tool, click the left

mouse button once. The tool is selected and the cursor shows the
appropriate icon.

Double-left-clicking over a given tool will erase that tool’s last
action, even if a different tool is active.

Double-left-clicking in each Palettes and windows title bar will
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dock them around the Chart Window.

Right-clicking on a palette tool brings up the context menu with
options to change transparency, button size, or toggle text labels

on/off.

Charts Overview

MaxSea is compatible with electronic charts from a number of

publishers.  Some require that their charts be installed with a setup
program included on their chart disk, and other charts can be

opened directly from the CD or from the hard disk when copied.
License codes are used in most cases to ‘unlock’ charts for use with

MaxSea (see p18 for installation information).

There are two chart format types; raster and vector.

Raster Charts use bitmapped (scanned) data to reproduce paper

charts. Essentially a raster chart is a digital picture of a paper chart.
MaxSea geographically references these scanned images, ensuring

accurate display of the vessels position within the limitations of the
chart’s accuracy.

Advantages:

• Appearance is exactly the same as paper charts

• Easy to install and view

Disadvantages:

• Raster chart appearance depends on proper scaling. If the
proper scale chart is not available, the chart must be “over

zoomed.”

• Detailed embedded information is not available

• Labels and units information cannot be changed (as

changing depth units)



Getting Started Guide

48

Vector Charts use “intelligent” data to build the chart display. It is

stored in layers and records all chart features, such as coastlines,
buoys, lights, etc. These features and their attributes (position,

color, size, shape, etc.) are stored in a database that allows them to
be selectively displayed. Vector charts are very accurate at their

reference scales (as long as they are not “over-zoomed”), but can
appear quite different from traditional paper charts.

Advantages:

• Chart display does not degrade with zooming

• Depth units and appearance can be changed

• Details on the chart can be hidden, making the display less
cluttered

• Specific Objects on a chart (i.e. buoys) can be clicked for
more information

Disadvantages:

• Appearance is different from paper charts

• If a vector chart is magnified beyond its reference scale, it

does not appear less detailed than a normal scale, but it is
less accurate.  

• Vector charts are not considered as reliable as raster charts

Please refer to the HELP menu in MaxSea for complete details on

working with charts.
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Chart Types

The following table provides a quick reference of chart format,

coverage and installation procedures.  Specific details about each
chart type can be found in the on-line help system.  

Chart Type Installation
License

Code
Coverage Web Site

C-MAP

NT CD
Vector

Setup

Program
C-MAP World www.c-map.com

C-MAP

NT Card
Vector N/A N/A World www.c-map.com

C-MAP

CM-93
Vector

Setup

Program
C-MAP World www.c-map.com

Mapmedia
v1

Raster File Copy
MaxSea

Europe,
Africa, South

America,
South Pacific

www.mapmedia.com

Mapmedia
mm2

Raster
Setup
Program

MaxSea

Caribbean,
Channel Bay

of  B iscay,
Great Britain -
North Sea,
Mediterranean

Sea, South
P a c i f i c  -
Polynesia.

www.mapmedia.com

Maptech Raster File Copy N/A
North/South
America,
Europe

www.maptech.com

Maptech
BSB4
format

Raster File Copy
Maptech
codes

North/South
America,
Europe

www.maptech.com

Softchart Raster File Copy N/A
North/South
America

www.softcharts.com
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Opening Charts

The software is compatible with cartographic data from several

publishers.  This data may be in vector or raster format, and

saved on your hard disk.  Note that either C-Map or Mapmedia
charts will be available depending on your configuration.

  To open a chart, select [Open chart...] from the [File] menu.
MaxSea automatically searches your “My Documents” folder for

charts, then displays a dialog box which lists all available charts.,
etc... (See p18 to install charts)

The first time, a warning box will appear about the use of digitized
charts and documents. Click Accept if you agree.

Choosing Chart Scale

MaxSea will display all of your raster charts – even if they are from
different chart publishers – seamlessly in the same window.  This

allows you to navigate without having to worry about opening up
individual charts.  When you zoom in or out using raster charts,

MaxSea will automatically display the best chart available at that
scale.

When zoomed-out, MaxSea will show you available detailed charts
with a pink border.

The scale of a chart can be changed in several ways:

1 - Using the Magnifying tool

Near the top of the Toolbar is a Magnifying glass tool. Select the

Magnifying tool to change chart scale. Simply drag an area on the
chart with this tool to zoom into it. Make a simple click on the chart

to zoom out.

2 - Using the "Zoom In" and "Zoom Out" buttons
Click the "Zoom Out" button on the Toolbar (Magnifying glass on

the right) to zoom out. Click the "Zoom In" button on the Toolbar
(Magnifying glass on the left) to zoom out.

3 - Use the mouse wheel (if available) to zoom in and zoom

out
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4 - Using the Scale Drop Down menu from the Right-Click

Menu

Right-click with any tool in

the chart window to bring up
the Scale drop down menu.

The available scales are
indicated by a drawing

symbol next to their
numbers. The current chart

scale in the "Scale Pop Up" is
shown in Bold.

Left-click the mouse button
on the desired scale. The

chart will be drawn at this
scale and centered on the

point clicked.

5 – Use the + or – key of your Keyboard.
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Notes:

(1) - the symbol next to available scales indicates the type of data

available:  

Chart Data,

Depth Data,

Chart and Depth Data.

(2) - Chart Scale information is always displayed in the lower left

of the Chart Window as it is shown in the following picture. You
can hide this information by accessing the Display Options dialog

box and unchecking the “Scale display” option box.
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Moving the chart

1 - Hand tool

Left click on the hand tool and move the cursor over the chart to
the center of the screen.

• Single left-click and press to grab and move the chart.

• Double-click to access the chart data screen. Here you will

find data on the chart source, its official number, origin
country, scale, datum, and the depth units (feet, meters,

or fathoms).

• As with other tools, right-clicking brings up the context

menu allowing changing the chart scale accessing the
chart data screen, etc.

2 - With Other Tools

You can use the mouse buttons to move the chart.

• Move the mouse near a window border. When the cursor

changes to an arrow, click on the left button to move the
chart in the direction of the arrow.

Upper Left

Upper Middle
Upper right corner

Lower Left Lower Middle Lower right corner
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• Press the wheel (if you have wheel mouse) to activate free

mode panning, and then release to exit.

Waypoints & Routes

There are two types of routes that can be displayed on the chart; the
Planning Route and the Active Route. The difference between the two

is simple - an Active Route is one that MaxSea is following /
navigating while you are underway. A Planning Route is not currently

being navigated, and you can make corrections or additions at any
time. This chapter and the "Planning Route" and "Active Route"

chapters explain how to create a route (using the Route tool or the
Waypoint tool). In the Active Route paragraph you will learn how to

activate a route and follow it on the chart.

Use the Plotting (Pencil) Tool to plot as many
Waypoints as you wish. A waypoint layer must be

selected / active.

Use "Go To " tool to create a Quick Point and
activate it.

Use the Route tool to build a Planning Route.
Make sure to Double-click on this tool before

creating a new route to ensure that there are no
other routes that are "selected."

 



MaxSea Marine Software

55

You can work on a Planning Route while following an Active

Route.

Planning Route

MaxSea enables you to create a Planning Route by placing and

linking together several Waypoints on the chart. A Planning Route is
not in use until it is activated, so you can work with a Planning Route

while actively navigating another Active Route.

IMPORTANT - When starting to create a new Planning Route, be
sure that no other Planning Route is shown on the chart. If a

Planning Route is already displayed, double-click upon the Route
tool in the Toolbar to unselect the existing Planning Route, then

start to plot new Planning Route.

Note: Routes are automatically stored in the Routes Centers. To
call up the Routes Center select [Centers] from the [Route]

menu and choose [Routes]
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Fig.1

You can easily plot a route on the chart using the Route tool. The
Planning Route is drawn on the chart with series of

QuickWaypoints (or Waypoints) linked with orange dotted lines.
When you make a route with the Route Tool, you can either use

existing waypoints (2) or make new ones (1). If you don't use (click
on) existing Waypoints, QuickWaypoints will be automatically created

(1). These QuickWaypoints are not added to the Waypoint database
and are automatically deleted when the route is erased.

Selected Route (Planning Route) is surrounded in orange as shown in
Fig1. Unselected route are display in blue. To select a route, simply

choose the Finger Tool and click on a blue route. The route will
become selected (orange) and characteristic of each leg (route plan)

will be displayed in the Selected Route Center. To call up the
Selected Routes Center select [Centers] from the [Route] menu

and choose [Selected Routes]

Several methods can be used to create a Planning Route:

Using Route tool for drawing it on the chart.
Using Routes Center list for editing a Planning Route.

Using Waypoints Center lists for entering a planning Route.
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Use the Route tool to draw a Planning Route on the chart

This method allows you to directly create a planning route on the
chart with new position.

1. Select the Route Tool and move the cursor to the desired
starting point.

2. Click directly on the chart. A blue square (QuickWaypoint) is
displayed at the point clicked and is named number (1).

3. Create additional QuickWaypoints by clicking points further
along the route. These QuickWaypoints will be successively

numbered (2), (3), etc.
4. The route is automatically and simultaneously added to the

Routes Center list. (The orange line in the Routes Center
corresponds to the present planning route.)

Place Waypoints on the chart and build a Planning Route.

This method allows you to create a Planning Route from known
positions. These positions are listed in the Waypoints Center and can

be displayed on the chart with a blue circle.
1. Select the Pencil tool (and make sure that a Waypoint layer

is selected),
2. Choose a shape (icon) and color for your Waypoints

3. Move the Plotting Tool on the chart and click to record
Waypoints (each Waypoint will be automatically saved in

the Waypoints Database).
4. When you have plotted enough Waypoints, you may change

the tool and select the Route tool to create the Route by
selecting and connecting any combination of these

waypoints, or new QuickWaypoints.
5. As above, the route is automatically chosen as the actual

Planning Route. It is drawn on the chart with orange dotted
lines and characteristic of each leg (route plan) will be

displayed in the Selected Route Center. To call up the
Selected Routes Center select [Centers] from the [Route]

menu and choose [Selected Routes]
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Left-click a Waypoint with the Route tool and it will be added further

in the Planning Route.

TIPS - Right click a Waypoint symbol or a Leg Route on the

chart and it will call up their appropriate contextual menu. It
allows access at any time to the "Properties" dialog selection

and other tools appropriate to a Waypoint and/or a Planning
Route.

To quickly unselect a planning route, double click the Route
tool.

Route Center
All your Routes are displayed in the Routes Center, and they are

automatically saved in a database. You can create or import as many
routes as you wish. To call up the Routes Center select [Centers]

from the [Route] menu and choose [Routes]
The Routes Center window appears at the bottom of the screen and

lists all previously created routes. Click on the box to the left of any
route to select the route you want to work with. Once a route is

selected, the box to the left of that route will turn blue.
Simultaneously the route is selected and colored in orange in the

Center and on the Chart. When a Route is selected, all details about
the trip are reported in the Selected Route Center.

Check the HELP menu in MaxSea for complete details for editing and

entering a Planning Route from the Centers list, customizing a
Planning Route such as the ETA and also measuring Headings,

Distances and Bearings.
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Active Route

An Active Route is one that MaxSea will actively navigate. MaxSea
will display the distance, bearing and time to go to the next

Waypoint on the route based upon data coming in from the
instruments.

An active Route can be created by activating a planning route. Only
one Route can be active at a time. The Active Route is displayed in

red (while the Selected planning route is displayed in orange), and
its active Waypoint is filed in with red. When Display XTE option is

ON (selected by default), the Security XTE area is delimited with two
dotted lines, green and red, on each side of the active route. To set

up the default XTE length, select [Options: Route] from the
[Route] menu and change the “Default Leg XTE”. The Passed Legs

are drawn with grey dotted lines as it is shown in the picture.

When the route is activated and the computer’s data output is
connected to an autopilot, MaxSea will send the appropriate data to

the autopilot so that it can control the steering of the vessel.
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Creating a Quick Route with the “Go To” Tool

1. Click the "Go to" tool on Toolbar
2. Click any where on the chart or on an existing waypoint.

3. If an Active Route is already on, a message will ask  you
to cancel it, click Yes to confirm

4. Then the Quick Route is activated.

Note that a ”Quick Route" is temporary and when the active route
is cancelled or ended, it will be deleted.

Quick Route representation
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Activating a Planning Route

You can activate an existing Planning Route by:
1. Click with the “Go to” Tool upon the leg of the Planning

Route from which you want to start following the route
(usually the first leg)

2. Right click anywhere along the route to display a
contextual (pop-up) menu. Either choose "Activate

Planning Route" or "Activate Route at selected Leg" (see
following pictures).

When "Activate Planning Route"

option is chosen

When "Activate Route at selected

Leg option" is chosen

Note: When the chart scale value is chosen and Auto Scale mode is selected,
the software will automatically change the chart scale as the ship approaches
Waypoint.

See the HELP menu in MaxSea for complete details on the Auto-

Scale Function. This can be done under the Route properties dialog.

When approaching a waypoint during an Active Route, the
waypoint is switched by one of two methods:

1. The boat passes an imaginary perpendicular line passing

through the center of the destination waypoint.
2. The boat comes within the Arrival Alarm Range.
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You can track your actual active route by clicking the Track button

from the Toolbar (see following chapter "Tracking").

See the HELP menu in MaxSea for complete details about route,
Steering Data and Steering Display.

Cancelling Active Route

When you reach the last waypoint of the Active Route, the Active

Route is cancelled; if you want to cancel the Active Route before
reaching the last waypoint, select Cancel Active Route from the

Route menu, or right click on the Active Route and choose Cancel
Active Route.

TIPS - To quickly cancel an active route, double click on the

“Go To” tool.

See the HELP menu in MaxSea for complete details for following

easily the navigation from the Steering Data and Graph windows,
and with more details from the Active Route Center.
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Waypoints and Marks

Waypoints and personal marks can be saved onto layer(s).  When

MaxSea is started, an empty waypoint layer (named “Waypoint”)
and an empty PTF file layer (named "Layer.ptf") are created.

When a personal user mark is drawn in MaxSea, the information is
actually being displayed in its own transparent ‘layer’ over the

chart.
While it may appear that there is new visual information on the

chart itself, MaxSea stores this information separately.  Therefore,
this information can be displayed or hidden independently of the

chart information.
For example as shown in Fig. 1, begin with a chart  Layer (1), add

marks and MaxSea stores them on a PTF layer (2) which lies over
the chart , then add waypoints  and MaxSea stores them on a

waypoint  layer (3) and in database.
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The resulting image appears as if the marks and waypoints are

drawn directly on the chart.

There are two categories of data layers:

1. Waypoint and Routes layers
2. User data layers  (PTF File)

Waypoint Layer:

By default, all your waypoints are created on the “Waypoint” layer.
To create a new Waypoint Layer

1. Go to the [File] menu, point [New] and choose
[WP layer...]

2. Enter new layer name
3. Click OK
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All the Waypoints you will create will be saved on this new layer

(known as active layer). You may change icon and color of
Waypoint using the plotting icon and color button. To switch

active layers, just click and hold down the mouse on the Plotting
Tool. This will show a drop-down menu where you can select the

active layer. You can also change the Waypoint layer attached to
a waypoint in the Waypoint Center or in the Waypoint Properties

box. To show or hide each waypoints layers, use the Waypoint &
Route button on the Chart toolbar and choose which one you want

to show or hide. All the Waypoints are stored in the Waypoints
Center. To call up the Waypoints Center select [Centers] from

the [Route] menu and choose [Waypoints].

Notes
When a waypoint layer becomes empty, it is automatically deleted. The
number of waypoint is unlimited

User data Layer (PTF File):

PTF layers are used to draw personal marks, area, circle etc…. A
User data layer can be treated like any other file used in a

Windows program, like documents in a word processing
program.  To create a new PTF layer:

1. Go to the [File] menu, point [New] and choose [PTF
layer...]

2. To open an existing layer, either select [Open...] or
press on the keyboard “Ctrl + O”.

3. To close the active layer either select [Close] or press
on the keyboard “Ctrl + W", then choose the file to

close.
4. To save the active layer either select [Save...] or press

on the keyboard “Ctrl + S".
5. To save on to a new layer, select [Save As...], then

choose a path and a name.
There can be more than one layer opened at the same time.

The layer button in the chart palette can be used to show/hide
the opened layers. With many layers open, only one can be
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active. The active layer is the one that new marks will be

written to, and is set from the plotting tool drop-down menu.

When a PTF file layer is selected, you can choose the type (line,
area, circle, text) using Mark type selection boxes located in the

lower half of the Toolbar.
1. Choose the drawing type and select style parameters.

Use the Plotting Setup tools to change the color, line,
width, drawing, texture and font size.

2. Select the Plotting pen tool from the Toolbar, place the
cursor on screen; and then click.  A mark (point, line,

area, circle or text) will be displayed at the position
clicked.

Notes
The number of user data layer (PTF file) is unlimited. New user data files are

stored by default at first level of "My Documents | My MaxSea" repertory. To
change the default repertory, go to the [File] menu and choose [Option: File].

Track your actual course

This chapter describes details about how to display and save the

track of your ship.
Click on the "Track on/off" button in the Toolbar. The Track off

button changes to Track on (red background).

The track is then displayed on the chart and automatically saved
onto the PTF file Layer[WGS84] by default.
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Click on the Track on/off button again in the Toolbar to deactivate
the track saving function.

The program gives you the option to save the track permanently in
a "PTF" layer file on the hard drive.
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• Left-clicking on "Save" will save the track in the layer.ptf
and clicking on "Do not save" will not save the track.

• Left-clicking on "New file" will save the track in a user
selected file.

• Left-clicking on "Open file" has two effects: It will open an
existing file and then save the track in it.

Don’t forget to turn ON the Layer Information button in the

ChartPalette to display the PTF file over the chart.

Notes:
(1) - save the track onto a new layer for later use.
(2) - convert the recorded track as a new active route using the context (right

click) menu.

Using Weather Data
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Forecasts and weather data are obtained through MaxSea's exclusive
Chopper interface, which allows you to receive data via e-mail that

you can overlay onto your charts.
Chopper’s built-in compression algorithm is optimized for binary data

(GRIB format), making downloading over satellite phones and single
side band (SSB) quicker. File sizes are between 30-200KB depending

on the area and amount of data you request. MaxSea Chopper can
be used with any Internet connection as long as it allows you to

receive data and attachments through email (mandatory for GRIB
reception). Consequently, that includes all connections such as RTC

lines, ADSL, Cable, but also GSM cellular phones in the coverage
area, Inmarsat, Irridium, BLUE, Mini-M, etc.

MaxSea Chopper simply activates the default email client which is
associated to your internet browser when you click "Get it by

email".  With MS Internet Explorer, check TOOLS / INTERNET
OPTIONS / PROGRAMS for settings.

Please note that the email reception is out of the Maxsea support

field. Please contact your Telecom / Internet Service Provider if you
encounter difficulties in setting up your connection

To request your weather file, select [Chopper: Navcenter

Forecast...] from the [Weather] menu. First choose a region /
model to access the request page will appear. You can then select

the region with your mouse, amount and type of forecast data, and
click on the "Get it by e-mail" button at the top of the screen. (The

first time you access Chopper, you will have to register your e-mail
address.)
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Chopper will launch your default e-mail program (typically Outlook),
allowing you to send the weather request to the Navcenter weather

server.
You will receive an e-mail within 5-10 minutes with an attachment.

Double-clicking the attachment will open the weather file in MaxSea.

Note: We suggest using “MaxSea compression” which creates the smallest
possible weather file to speed up your download time.

The following example shows sea surface temperature (colors),

current (yellow arrows), and wind (feathers) as you would see it in
MaxSea.
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Clicking anywhere on the chart with the finger selection tool will give

you full weather details for that point.

Use the Date/Time tools in the chart palette to advance the weather
forecast period.  

Use the Weather Button in the Chart Palette to Turn ON or OFF the

weather layer. If you click on the down
arrow at the right of the button, a drop-

down menu will appear where you will be
able to choose each weather data layer

independently. In this example, only the
Wind, Surface Pressure and SST are shown

on the chart.
Note that if an icon is grey, this means that

the data has not been selected when the
request was proceed.
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Dead Reckoning function

The Dead Reckoning function is used for testing, planning, or if the

vessel’s GPS system fail.  
Dead Reckoning calculates the ship’s position using a starting

position, the course and the speed.
Dead Reckoning also simulates vessel movement on a home

computer without a GPS connection.

Notes:
    (1)  Dead Reckoning calculations begin at the last position simulated or

acquired by the GPS.
    (2)  MaxSea starts in acquisition mode (Dead Reckoning turned off) by
default.

Switch to Dead Reckoning mode under [Utilities] on the menu

bar.

Acknowledge the warning concerning loss of real-time data, and the
warning which appears, "click OK” to confirm Dead Reckoning

mode, GPS input is turned off.

The first time dead reckoning is used, the vessel will be placed off
the coast of Africa at 0 Lat. and 0 Lon.  Drag the boat symbol by

selecting the Position Modification tool from the Tool Palette:

By default the Dead Reckoning palette appears docked on the upper

right-hand corner of the layers toolbar, as it's shown below, and the
Nav Data palette becomes the Dead Reckoning control center.

To modify the boat position use the Dead Reckoning symbols.  The

Dead Reckoning symbols can be displayed in a floating palette as
shown below.
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You can also move the boat by clicking on the boat position

button  in the dead reckoning toolbar which centers the boat in

the middle of the screen.
The other buttons in the dead reckoning toolbar allow you to

simulate boat speed and heading:

The  and  symbols are used to change the boat's speed.

The two symbols  and   are used to change the COG boat
clockwise or counter clockwise. The modified values are

displayed in the Nav data box.

Exiting the software

To Exit the software:
1. Choose [Exit] from the [File] menu or click the "X" located

in the upper right-hand corner of the window.
2. A second dialog box warns that any open layer files should

be saved.

• Click Yes to close and save the file.

• Click No to close the file without saving it.

Note: If marks have been plotted and a new file has not been created, MaxSea
saves them automatically in the activated layer.

IMPORTANT - DO NOT TURN THE COMPUTER OFF BEFORE

CLOSING MAXSEA SOFTWARE.  Doing so may cause damage to
the software, and can corrupt active data! Close the software

as indicated above; then turn the computer off.
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Appendix: Connect MaxSea to NavNet

Introduction: To connect MaxSea to the NavNet network, simply

connect your PC to the network hub using a regular RJ45 Ethernet
cable. MaxSea will exist on the network like a regular NavNet

Display, so you will have to set up the IP of the computer and give
MaxSea a Hostname, just like you would do with another NavNet

display.
Note: In order to connect MaxSea to the NavNet network, you need

to have a MaxSea NavNet compatible product (such as MaxSea
NavNet Commander or MaxSea NavNet Explorer).

Configure the Navnet Radar and NAV information

On the NavNet display with BBWGPS or other GPS connected to it,

press “Menu,” then “System Configuration” then “System Setup”
then “Port Setup” then “Output Through Network”. Turn the following

sentences to ON to get the proper information into MaxSea: DPT,
GGA, MTW, VHW, VTG, ZDA, HDT, MWV. If using two or more

Navnet displays, make sure to only enable these outputs on one
display (the one that is connected directly to position source.)  Press

“Return” when done. Press “DISP” on the NavNet Radar to show the
display selection screen, and then press any Soft-Key. This will show

the network information screen. Write down the hostname of the
Radar Source (this information is displayed in brackets)

Ex: “1” corresponds to the hostname “NAVNET1” (in NavNetVX2)

If you have a BBFF1 or BBFF3 network sounder, write down the
name of the Sounder Source (usually “ETR0” in NavNetVX2 or

“SOUNDER” in Navnet1).

Configure the PC

You will have to give a hostname to MaxSea (ex: NAVNET4). This
hostname must be unique and not already taken by another NavNet

display. You will have to set up the IP of the computer according to
the hostname that you will give to MaxSea. If you choose NAVNET4

for MaxSea (recommended), the IP of the computer must be
172.31.3.4 (if you choose NAVNET1 the IP must be 172.31.3.1)
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To set up the computer’s IP:

Go to “Start” and select “Control Panel”

Open “Network Connections”

Right Click on “Local Area Connection” and select “Properties”
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Select “Internet Protocol (TCP/IP)” and click on “Properties”

Fill the IP fields as shown below (enter the IP corresponding to the
Hostname chosen for MaxSea)
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Click on OK to confirm and close the 2 windows.

Note that the new IP can take up to 20 seconds to be recognized. A

pop-up in the lower right corner should show when the IP is correctly
set. Turn OFF any Firewall that could prevent data to be exchanged

between NavNet and the PC. You may also have to restart your
computer.

Configure MaxSea

Launch MaxSea and select “Options : Navnet” in the “Utilities” menu.

Choose the NavNet version in the drop-down menu
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- In the “Radar Source” option, put the hostname of your Navnet
that has the Radar connected.

- In the “ETR Source” option, put the name of your Sounder
- In the “Host Name” option, put “NAVNET4” (or whatever hostname

you have chosen for MaxSea)
- Put the hostname of all your Navnet displays in the Chart Source

(MaxSea will search for chart data). Note that MaxSea will only show
C-Map charts.

ARPA/AIS Option:

If you have the mobile module for MaxSea and the ARPA board for

your NavNet and/or have AIS connected to NavNet, you have to add
an instrument in MaxSea to display the Targets. Select “Data Input-

Output” in the “Utilities” menu of MaxSea. Click on the “Radar & AIS”

tab. Click on “Add Instrument…”. Select NavNet and press “Next>”.
Select NavNet ARPA data and click “Next>”. Click on “Finish” then

“Okay” to confirm.
You may have to repeat this procedure if you want to add AIS and

select “NavNet AIS Data” in the last selection box.
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 Dongle or Serial Number

Dongle Update Codes
Code 1

Code 2

Code 3

Charts, Data, and Other Codes




